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Conventions 

The typographic conventions used in this help are described below. 

Convention Description 

Bold Used to denote components of the user interface such as buttons, 
field names, menus, and menu options. 

For example, the New button. 

Menu...MenuOption Select the menu from the menu bar then select the menu option 
from the menu. 

For example, File...Open would mean to select the File menu 
and then the Open option. 

CAPS Used to denote the name of a key on the keyboard. 

For example, the ENTER key. 

Italics Used to denote emphasis, captions and the result of an action in 
a procedure. 

 

   

Technical Support 
  General enquiries on the QPt should be sent to: 

HREM Research Inc. 
Email: support@hremresearch.com 
Web: www.hremresearch.com 
 

   

Copyright Statements 
  © Copyright 2005-2021 HREM Research Inc.  

 
All rights reserved. This manual is protected by international copyright laws 
and treaties. Unauthorized reproduction and distribution of this manual, or any 
portion of it, will be prosecuted to the maximum extent possible and may result 
in severe civil and criminal penalties. 
 
DigitalMicrograph is a trademark of Gatan Inc.  
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1. Introduction 
 
 
 
 
 
 
  The QPt (Quantitative Phase Technology) is a plug-in for use in Gatan’s 

DigitalMicrograph of GMS (Gatan Microscopy Suite).  
 
This QPt manual is written to provide information on the basic functions of the 
QPt plug-in, a procedure for installation of the Plug-In, and some general tips 
on operation.  This Guide assumes the user is familiar with image manipulation 
using DigitalMicrograph as well as Windows operating system. 
 
 

1.1  How QPt works?  

   
  The QPt takes digital intensity images and processes them to yield the phase of 

the object under investigation. 
 
The QPt relies on the Transport of Intensity Equation (TIE) that is a differential 
equation between intensity and phase: 
 

!
"
#
#$ %('($) = −∇!" ∙ .%('($)∇!"/('($)0 

 
Here, %('($) and /('($) are the intensity and the phase of the object wave, 
respectively, and ∇!" is the two-dimensional gradient operator, say  
∇!"/('($) = (#/('($) #'⁄ , 	#/('($) #(⁄ ). 
 
Normally, the QPt uses three images taken with the same defocus step, and 
#%('($) #$⁄  is approximated with the difference between the intensities of the 
first and third images. When we use the second (middle) image as %('($), the 
TIE becomes an equation for /('($), the phase of the middle image. 
 
 

1.2  Advantages of Using QPt 

   
  No Special Optics Required to observe a phase object 

Phase imaging with electrons is an advanced research procedure using electron 
holography, which requires an electron bi-prism. 

Electron holography gives only a mixture of phase and amplitude information 
(a complex wave), and requires a certain level of skill to obtain useful images.  
 
Electromagnetic Field Observation (QPt Only) 
The QPt includes the functionalities to estimate and analyze magnetic/electric 
field from the phase image.  
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(Biological sample) Obtaining Detail without the Use of Stains at Focus 
In the case of the biological sample that is a phase object, the use of stains is 
necessary to enhance the intensity contrast of an image, which may also change 
the nature of the sample being analyzed.  Also, some stains need to be handled 
with care as they may be toxic. 

Alternatively, in the case of the phase object, the image is often taken slightly 
out of focus to achieve better contrast and to highlight structures. However, it 
inevitably introduces some blur and also artifacts.  

Using the QPt, the use of stains is unnecessary, and the retrieved phase image 
is sharp, and reflect the sample structure, when the middle image is captured at 
the true focus of the sample. If the middle mage is out-of-focus, we can obtain 
the image at the just focus by propagating the retrieved complex wave.  
 
Aberration Correction (HREM Module) 
The combination of the amplitude and phase information completely defines 
the transmitted complex wave field. Therefore, for example, we can propagate 
the complex wave to any desired plane.  

In electron microscopy, a spherical aberration limits a resolution contrary to 
optical microscopy. Obtaining a complex wave, however, we can correct the 
spherical aberration and adjust a defocus. 

 

 

1.3  Projects and Images  

   
  The QPt provides a routine to acquire a series of the images on-line from an 

electron microscope. Or, you can use the images that are already acquired and 
saved.  
 
A QPt project is made from three or two images taken from a particular sample 
at different image planes. Here, the three images should be taken with the same 
defocus step.  

Three image case: 
Symmetric project: negative defocus, in-focus and positive defocus images.  
Asymmetric project: three images taken with the same defocus step. Here, the 
center image is not an in-focus image. 

Two image case: 
Symmetric project: negative defocus, and positive defocus images. The in-
focus image is approximated by the average of the negative and positive 
defocus images. 
Asymmetric project: two images taken with an arbitrary defocus step. The 
center image is approximated by the average of the negative and positive 
defocus images. 
 

  NOTE: In high resolution electron microscopy (HREM) the center image in 
the sequence images may not be literally in-focus. In this case the QPt gives a 
phase distribution at the middle plane. The complex wave at the middle plane 
can be propagated to the in-focus plane.  For more details in atomic resolution 
application of the QPt, see HREM Modules. 
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2. Image Alignment 
 
 
 
 
 
 
  Image alignment is essential for the phase evaluation using the QPt. This is 

because the Transport of Intensity Equation (TIE), on which QPt is based, uses 
an image difference during the processing  
 

2.1  How to Align Images  

   

  When the images are captured using an electron microscope or digitized after 
image acquisition, various image distortions can occur. Thus, the QPt gives a 
variety of alignment procedures as explained below. To align the images, the 
images have to be stacked to a Project image. 

  It is advisable to place the markers that tell to the alignment routine the same 
image points on each image. The marker may be placed by using HREM 
Mouse tool, or may be a Line ROI or Line Annotation. 

   
The QPt gives a variety of procedures for assisted manual alignment using the 
markers and automatic alignment if the image set is almost aligned as listed 
below: 
• Manual Alignment 
• Affine Alignment 
• Segment Alignment 
• Fourier Alignment 
• Translation Alignment 

   

TIPS:  Rough Manual Alignment 

  Affine alignment requires multiple mouse points on each image, when an 
image displacement and/or an image distortion are appreciable. 

  However, if there is no significant distortion, but large image displacement, 
you can use firstly "Translation Alignment," then refine the aligned Project 
image by using "Affine Alignment," which requires the mouse points only on 
one image. 

  When the image distortion is significant, you can firstly align the images by 
placing two HREM mouse points or one Line Annotation (or ROI) to show the 
corresponding positions on each image, then use "Affine Alignment" without 
applying cross-correlation ("Cross Correlation" Mode is set to "none"). If you 
want, you can specify more mouse points or more line annotations (or ROIs) on 
each image. The roughly aligned Project image will be finely aligned by using 
again "Affine Alignment" with applying cross correlation. 
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TIPS:  Use Previous Alignment 
  In order to achieve good alignment, you can use trend-subtracted images (use 

Trend Subtract command), or edge-enhanced images (say, obtained with Sobel 
Spatial filter, Laplacian filter etc. of the DM Process command) of the original 
images. Then, the alignment conditions can be applied to the original image by 
using "Use Previous Alignment." 

  When a cross-correlation peak becomes negative, you may want to invert an 
image contrast of one of the images to get better alignment conditions. 

   

   

2.2  Manual Alignment  

   

  In some cases, it may be difficult to find distinct small image features. Then, you 
may want to use the Manual Alignment. If you place a Line Annotation (or ROI) 
that connects image features on each image, the Manual alignment adjusts a 
scale and rotation of the image by using the Lines. You can use two HREM 
Mouse points as the markers instead of the Line Annotation (or ROI). 

The figures below show an image alignment window and the Manual alignment 
tool. The Manual alignment tool aligns at each time two images, namely the 
Target image with respect to the Reference image, which are chosen by the 
image selector (top part) of the alignment tool. 

 
 

 
Image alignment window Manual Alignment tool 

  It is advisable to use the most distinct image as the Reference image at the 
beginning. After the first alignment, the possible image for the reference will be 
listed in the Reference image selection, and only remaining images to be aligned 
will be listed in the Target image selection. 
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The Manual alignment tool gives a variety of modes to check both Reference and 
Target images simultaneously. The tool also gives a possibility to adjust a 
contrast of the stacked images. You may note that the image display mode will 
not work well, if the contrasts of two images in alignment show a big difference. 

   

   

2.3  Affine Alignment  

   

  This is a linear image alignment by adjusting a scale and rotation angle. Here, the 
scale and rotation angle will be estimated by local correlations of specified small 
image areas. The nine image areas arranged by 3x3 evenly spaced will be used 
by default. The size of each image area (in pixels) will be selected from 
32/64/128/256/512. 

However, the alignment using evenly spaced 3x3 areas will fail, if your image 
does not have specific features at some default image areas, or if an image 
displacement or an image distortion is relatively large. 

If the images are almost aligned but some of default 3x3 image areas for 
alignment do not have specific features, you can manually specify the centers of 
image areas on one image by using the HREM mouse tool (the fat mouse icon 
added to the Standard Tools). The following image shows some mouse clicks, 
each of which defines image centers. 

   

 
You don't need to specify the corresponding image areas on other image(s), since 
the alignment routine will automatically use the same image areas on other 
image(s). 
 

TIPS:  How to delete a mouse click: Click a point close to the mouse click to be deleted 
with the SHIFT key down. Then, the mouse clicks will be renumbered. 

NOTE:  When an image displacement or an image distortion is very large, you have to 
specify corresponding image areas on each image by using the HREM mouse 
tool (the fat mouse). In this case the number and sequence of the mouse clicks 
should be the same on all the images. 
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  On summary: 

1) When no mouse points are present on any images, the default image areas of 
3x3 will be used on all other images.  

2) When mouse points are present on one image, the same image areas will be 
used on other images.  

3) When the same number and sequence of mouse points are present on two 
images, the centers of image areas on the third image will be the mid points of 
the mouse points on two images.  

4) When the same number and sequence of mouse points are present on all the 
images, the user specified image areas will be used. 

NOTE:  When you want to use the image areas different from the default 3x3 areas, you 
have to specify the positions using the mouse click before launching the 
Alignment command. 

TIPS: 
 

You can fix the scale and/or rotation angle by uncheck Scaling and/or Rotation 
of the Option tab, if it is appropriate. 

   

   
 
 

2.4  Segment Alignment  
and Affine -> Segment Alignment  

   

  When an image distortion is not represented by a simple scale and rotation, 
namely an Affine transform, you can use non-linear position-dependent 
alignment. In this case the whole image is segmented into many small areas, 
and each image area will be displaced with different amounts. 

It is important to note that the images should be well aligned before applying 
the segment alignment. Thus, Affine -> Segment alignment will be a 
handy option. 

  This alignment may be valuable for medium resolution images where a non-
linear image distortion may be present.  

For the biological sample that is sensitive to electron beam irradiation, there 
may be an image distortion due to specimen degradation. In this case the 
segment alignment will be essential. 
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2.5  Fourier Alignment  
and Fourier -> Affine Alignment  

   

  When you want to align atomic resolution images taken from a crystalline 
specimen, spot positions of Fourier transform may be used to adjust a scale and 
rotation angle. After adjusting the scale and rotation angle, an image 
displacement will be adjusted using cross-correlation of the whole image area. 

It is noteworthy that the spot positions depend only on the image periodicities 
and not the image contrast. Therefore, the Fourier alignment is robust against a 
defocus change 

  You can use a Fourier transform calculated from any one of the images to be 
aligned. Then, the spots that will be used for alignment should be specified by 
using the HREM mouse tool as shown in the image below: 

   

  You have to select on Alignment tab the Reference image and its Fourier 
transform from the list of all active Fourier Transforms. 

NOTE:  When the image is over sampled, the Fourier spots will not appear so much 
away from the origin. Then, the Fourier alignment will not be so accurate. In 
this case, you may be able to use Fourier ->Affine alignment. 

TIPS: 
 

You can fix the scale and/or rotation angle by uncheck Scaling and/or Rotation 
of the Option tab, if it is appropriate. 

   

   

2.6  Translation Alignment  

   

  With this alignment mode, only an image translation is adjusted by the cross-
correlation over the whole image areas. Therefore, the scale and orientation of 
all images should be identical. 
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3. Phase Images 
 
 
 
 
 
 
  The QPt phase image contains the refractive information for the sample in a 

form that has not been available using any other method. This phase 
information is entirely independent of the sample absorption. These 
quantitative phase images tend to appear visually fuzzy but the data in them is 
more accurate because of the purity of the phase information. 
 
The phase images can be used as they are, or can be used to create magnetic/ 
electric field images.  Furthermore, by creating a complex wave using the 
intensity information, we can correct spherical aberration, or to propagate the 
complex wave to an arbitrary plane. 

   
   

3.1  High Pass Filter  

   

  The high pass filter controls an amount of details that is present in the image. 
At a High Pass Filter (HPF) setting of 0, the phase image can be quantitative, if 
there is no low frequency noise. As the HPF value is increased the spatial 
frequencies are gradually filtered out from the lowest frequency. This has two 
consequences: 1) strong low frequency noise is suppressed; but 2) the image 
becomes less quantitative. When the HPF values is increased too much, the 
image becomes more composed of boundary or edge details. 

  However, an electron micrograph is normally too noisy, and gives so-
called white noise over the whole frequency of its Fourier transform. 
The QPt algorithm tries to retrieve information by dividing the Fourier 
transform of image intensity by a squared modulus of frequency. Thus, 
the noise at low frequency is apt be amplified and gives a slowly varying 
strong background over the entire image. This slowly varying 
background easily hides the fine details of the phase distribution. 
Therefore, it is advisable to apply the HPF as low as possible to reveal 
the fine details of the phase. The following example shows phase 
distributions calculated from electron micrographs of magnetic material 
by changing the HPF value. 

NOTE:  The form of HPF (High Pass Filter) is the Tikhonov filter for 1 5#⁄ : 
5# (5$ + 7$)⁄ , where 5 is a frequency in Fourier space, and 7 is a HPF 
constant.  The HPF value 7 is given in pixels in Fourier space. Thus, the HPF 
attenuates low frequency components, and passes high frequency components 
with less attenuation. 
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Image generated with the High Pass Filter 
set to 0.  Fine details of the phase 
distribution are hidden by slowly 
varying strong background. 

 

Image generated with the High Pass Filter 
set to 5. The object phase distribution starts 
to be observed here.  

  

Image generated with the High Pass Filter 
set to 10. 

Image generated with the High Pass Filter 
set to 20. The image becomes more composed 
of boundary or edge details. 
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4. Field Filter Images 
 
 
 
 
 
 
  The phase measured by QPt is a consequence of the electron refractive index of 

either the electric field of the specimen material or the magnetic field structure 
of the specimen or a combination of both. 

Because deflection can be caused by the electric field as well as magnetic field, 
non-uniform magnetic sample may include deflections caused by a mixture of 
electric field and magnetic field. If the magnetic sample is not uniform, the 
phase change due to the electric and magnetic fields should be separated before 
applying the field filter. Thus, the field filter gives a magnetic field, only when 
the magnetic sample is homogenous and uniform. 

The field filter tool quantifies the direction and magnitude of the magnetic/ 
electric field from the slope of the phase image. Magnetic/Electric Field 
command displays the vector field in a RGB color with arrows of various sizes 
for a qualitative view, while Magnetic/Electric Field Raw command 
creates the complex image that is composed of the x- and y-components of 
the field vector for quantitative representation. 

   
RGB color image representation 
In the RBG color image, the magnetic/electric field vector is represented 
as colors according to the color wheel below, where a direction of the 
field vector is color coded, and a magnitude of the field vector is coded 
in the brightness of the color.  

  

 

 
Color Wheel: 
The direction and magnitude of the field 
determines the color displayed. 
 
 
Color Bar (below): The magnitude of the field 
determines the color displayed. 

  
 

  Complex image representation 
In the complex image display, the x- and y-components of the 
magnetic/electric field vector are encoded into real and imaginary parts 
of complex image. From the complex image you can create a magnitude 
image using Utility -> Complex to Real -> Amplitude. The vector field 
coordinates can be rotated, and a magnitude of the vector field along or 
perpendicular to the preferred direction can be read easily. See Field 
Filter -> Rotate Coordinates. 

   
   



 
 

QPt 
 

14 

4.1  Field Filter Options  

   

  The following examples use the phase image below obtained from of a 
magnetic material of uniform thickness. 

  

 

 
 

  To see the field filter image (see the left image below), select Field Filter -> 
Magnetic Field, when the project image is at frontmost.  The direction of the 
magnetic field is represented by changes in color as well as the arrows. The 
magnitude of the magnetic field is represented by the brightness of the image as 
well as the length of the arrows. 

   
To see only the arrows representing the direction and magnitude (the middle 
image), click on the Color (On/Off) submenu.  

   
To see only the color and intensity without the arrows (the right image), click 
on the Arrows (On/Off) submenu. 
The length and spacing of arrows as well as their color can be changed using 
the Field Filter Setup dialog of Field Filter.  

   

   
Field filter image  Magnetic field direction and 

magnitude represented only 
by arrows (Color: Off) 

 

Magnetic field direction and 
magnitude represented only 
by directional color (Arrow: 
Off) 
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  To see a color representation of the magnitude of the field without the color-
coded direction, click on the Direction (On/Off) menu. (see the left image 
below) 
 
To overlay the original image on the magnetic field while, click on the Image 
Blending (On/Off). (the right image) 
You can select an image to be blended and specify the amount of intensity 
information in the Field Filter Setup dialog.  

 

  
 Color representation of magnetic field 

magnitude (Direction: Off) 
The magnetic field including 
information from the in-focus image 
(Blend: On) 

   
   

4.2  Field Density Map  

   

  The field density map (the right image below) is the two-dimensional 
histogram of the magnetic/electric field vectors, which gives the two-
dimensional distribution of the field vectors. The number of bins of two-
dimensional histogram can be defined in the Field Density Map dialog. The 
intensity can be displayed in gray scale or pseudo-color. You may note that you 
can use a ROI to select the region for the density map. 

  
 Field density map corresponding to the ROI 
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5. Knife Edge Images 
 
 
 
 
 
 
  Knife-edge method (Schlieren method) is a simple method to observe a phase 

object. If your sample is a pure phase object, the amplitude of the exit wave 
after passing the sample will be constant. Therefore, no image feature will be 
observed, when the whole scattering ideally contributes to image formation. 
When a knife edge is used to cut out a half of the scattering distribution, 
however, even a pure phase object can be observed.  

The Knife Edge command emulates the behavior of the knife-edge method in 
the microscope. Select Knife Edge when the project image is at the front. Then, 
the knife-edge pattern in Fourier space and the corresponding knife-edge image 
will be shown. The distance to the Fourier space origin and the angle of the 
edge can be adjusted by using the Knife-Edge tab of the QPt tools (see 
Command Reference). 

The figures below show a knife-edge pattern in Fourier space (top left) and 
corresponding knife-edge image (top right). As you can see, the knife-edge 
image does not give quantitative information on the sample when compared 
with the phase image shown at bottom right. 

  

 

 

 
 Knife-edge pattern in Fourier space  Knife edge image  
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  Phase image 
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6. HREM Module (Option) 
 
 
 
 
 
 
  There is the optional module that is dedicated to high-resolution electron 

microscopy (HREM). It has been demonstrated that the QPt can be applicable 
even to atomic resolution images taken with a commonly used defocus step: 
Phase measurement of atomic resolution image using transport of intensity 
equation, Kazuo Ishizuka, Brendan Allman, Journal of Electron Microscopy, 
54 (2005) 191–197.  

Usually, HREM images are not taken at the in-focus and above and below it, 
but taken at the Scherzer (under) focus or further under defocuses. In this case, 
we can use a middle defocus image as an in-focus image, and other two 
defocus images as under and over defocus images. Then, we can determine the 
phase information at the middle plane. 

Using the HREM modules a wave field at an exit specimen surface (see Exit 
Surface WF...) or a wave field with a minimum amplitude variation (see 
Minimum Amplitude WF...) will be calculated from the wave field at the 
middle (in-focus) plane. 

   
  Defocus Step 
  A larger defocus step will give more intensity change, but there is an upper 

limit that depends on the resolution you want. The allowable defocus step 8 2⁄  
for a given resolution : will be given 

  
;82<

# (!":#)#
3! ≪ 1 

  where " is a wave length of electrons. Thus, the allowable defocus step is 
inversely proportional to :# and the wave length ". The following table shows 
some defocus distance between an under- and over-focus images (8): 

   
  Table: Allowable defocus distance between an under- and over-focus images 

for some resolutions and acceleration voltages 

  1/g 100 kV 200 kV 300 kV 

0.14 nm 4.2 nm 6.2 nm 9.5 nm 

0.2  8.4  12.4  19.0  

0.3  19.0  28.0  42.7  

1  211  311  474  

10  21.1 µm 31.1 µm 47.4 µm 
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  HPF Setting/Low Frequency Noise 
  During image formation the low frequency image components will be 

attenuated due to phase contrast transfer function (pCTF). Therefore, the QPt 
tries to recover these low frequency image components by dividing the 
spectrum by the spatial frequency squared.  However, at the same time low 
frequency noise will be amplified. Therefore, a non-zero high-pass filter (HPF) 
setting during the Phase calculation is usually required to suppress low 
frequency noise in the phase image. However, a HPF setting as low as possible 
should be used when you want to back-propagate a wave-front from a middle 
image (in-focus) plane to the specimen exit surface plane. For more 
information on the high-pass filter setting, see High Pass Filter section.  

  Furthermore, some low frequency noise will be reduced by masking low-
frequency components or applying a periodic lattice mask in the case of a 
crystal sample. These filtering in Fourier space will be easily performed under 
DigitalMicrograph environment. 

   
 
  Example 
  Here, we will show one example that demonstrates an applicability of the QPt 

to atomic resolution images. The image below shows one of the high-resolution 
images of Si3N4 obtained at NCEM, Berkeley (courtesy of C. Kisielowski).  

  

 
  We may note that this image was taken with a rather large under-focus of about 

270 nm, which is a several times of the Scherzer defocus, to extend the spatial 
envelope and transfer high-frequency information as much as possible.  

The small parts of three images are reproduced below to clarify subtle image 
change due to defocus variation of about 12 nm. Here, the left and right images 
correspond to an under and over-focus images, respectively, with respect to the 
center image. 
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  The left image below shows the phase distribution obtained by the QPt using 

the whole area of the three images shown above.  Here, the HPF setting is zero 
(0), and there is the big slowly varying phase change that extends over 55 rad, 
and the phase variation (less than half radian) due to atomic structure is hardly 
recognized.  

  
  The right image shows the reconstructed phase after applying the minimum 

HPF, where the phase map becomes almost flat, and an atomic structure can 
now be recognized. Here, small round features correspond to atomic columns 
of the sample. However, there are unsystematic features of several times of the 
atomic feature that come from low-frequency random noise. 

  It may be noted that the low-frequency noise below the lowest spot from a 
periodic structure can be easily eliminated using a low-pass filter. The left 
image below shows a small part of the phase distribution that is obtained by 
eliminating the low frequency noise. It may be noted that this phase 
distribution does not show the expected atomic structure of Si3N4. This is 
because this phase distribution corresponds to that at the plane of the center 
image, namely about 270 nm under-focus from the sample exit surface.  
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  We may note that the complex wave at the center image plane can be created 

using this phase distribution and the observed image intensity. Then, the 
complex wave can be propagated to any image plane.  At the same time, we 
can correct aberrations of the objective lens including a spherical aberration 
(Cs). 

The center image above shows the phase distribution at the specimen exit 
surface by propagating the wave with the nominal defocus (270 nm under-
focus) and correcting the spherical aberration at the same time. Here, the 
atomic structure of the sample (silicon six-membered rings) is clearly observed. 

The nominal defocus may not be accurate enough. The right image shows the 
phase distribution at the plane where an amplitude variation becomes 
minimum. Usually, the phase map at the minimum amplitude demonstrates 
more closely the structure model, if the sample is a phase object. Here, the 
contrast from even from nitrogen atoms connecting the six membered rings can 
be observed. 
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Quick Reference Guide 
 
 

The QPt Main Menu 
 

 
 
  

QPt Basic 

QPt  

HREM Module 
(Optional) 

Utilities 
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QPt (QPt Basic) 

 
 

Menu Description 

Acquire Images... Acquires three images using a Gatan CCD camera 

Setup images... Creates a project image from archived images 

Alignment Performs alignment of a project image. You can use various 
alignment procedures. For more information on the alignment 
procedures, see the sections for Manual, Affine, Translation, 
Fourier, Segment, and Use Previous Alignment. 

Phase… Generates a phase image using the QPt Tools. 

Manual Adjust for 
Phase 

Adjusts an aligned project image manually and updates the 
phase image. 

Generate Complex 
WF from Project 

Generates a complex wave function from the project.  

The phase should be estimated before applying this command. 
(The project keeps amplitude and phase information.) 

Band Pass Filter... Applies a special Band Pass Filter that passes also the center 
beam. Thus, the mean value of the image will be kept 
constant. 

Propagate WF Propagates the wave by a specified distance (defocus) or a set of 
defocuses. This command is useful, if the center image is not 
exactly in-focus. For more information on various procedures, 
see the sections for Manual Defocus, Focal Series, Single 
Defocus. 

Aberration Corrector Opens Aberration Corrector window (if not opened). 
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Acquire Images... Menu  
 
This menu opens the Acquire CTEM Image Series Setup dialog where you can control 
image acquisition conditions including a defocus step. When you press 'OK,' three or two 
images will be acquired automatically according to the setting at Number of Images. 

NOTE:  You may have to check an objective lens hysteresis which will affect an actual 
defocus value. It is advisable to establish a hysteresis loop and collect images 
along the same direction of the loop. 

 

Acquire CTEM Image Series Setup dialog (Control Tab) 

 
The components of the dialog are described below. 

Component Description 

Control Tab For information about the components of the Control tab, 
see  Control Tab Below. 

Setup Tab For information about the components of the Setup Tab, see   
Below. 

OK Closes the dialog and acquires three images using the 
specified parameters. 

Cancel Closes the dialog without acquiring images. 
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Control Tab 
Component Description 

Data Name Acquired images will be identified with this name, and a 
sequential number added after this name. 

Number of Images The number of images to be acquired, which should be three (3) 
or two (2). 

Focus Step (nm) Defocus difference between the images (in nm). The defocus 
direction is determined by Defocus Range in Setup.  

Use a Fixed DAC 
Step (nm) 

If checked, a constant DAC step will be used, and thus the 
defocus step will be fixed. 

NOTE: A required DAC to change a specified defocus may not 
be an integer value. In this case, an actual defocus is 
approximately equal to the specified value, and the defocus 
step may not be constant. This setting is useful, if a single DAC 
is coarse to realize a specified defocus step.   

Acquisition Focus 
Offset (nm) 

The defocus will be changed by this amount before taking 
images. 

Delay after Focus 
Change 

Delay time after changing a defocus (in sec) 

Save Each Image to 
Disk 

Acquired images will be saved onto a hard disk in the folder 
specified at Setup tab. 

Create a Stacked 
Image 

(Don't use this selection for QPt) One stacked image will 
be created. NOTE: The stack will not be saved.  

Convert to Integer 2 
Signed 

An acquired image will be saved as Integer 2 signed after 
converting from an Integer 4 signed. Use this option only when 
your image is known to be expressed as Integer 2 signed. 
(These days, an image will be acquired and saved as Integer 4 
signed, which requires a large memory space.) 
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Setup Tab 

 
Component Description 

Folder Acquired images will be saved into this folder, when 'Save Each 
Image to Disk' is selected. You can browse the folder directory. 

Focus Calibration  
(nm per DAC) 

Specifies a focus change in nm for a unit DAC change. 
This will be automatically specified, when you have Gatan's 
plug-in    to measure this value. 

Magnification Image magnification (This will be read from your microscope, 
if    possible.) 

Defocus Range Always use “Under to overfocus” 

Camera Control Selection of camera control protocol from CM commands and 
SSC/MSC commands. 
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Setup Images... Menu  
 

The opened images will be set up into a project image in the order listed in the "Window" 
menu. The TOP (FRONT) image should be most UNDER-FOCUS, and the defocus step 
should be positive. 

NOTE:  When you want to align images using a set of mouse clicks, you have to place the 
same number of mouse clicks on each image before select this Setup Images 
command. 

 
 
Setup Images dialog (Image Info Tab) 
 

 
 
Image Info Tab 

Component Description 

Project Name The images will be set up into a project with this name. 

Defocus Step Defocus difference between the images. The defocus step should 
be POSITIVE, namely the images should be accumulated from 
under- to over-focus. You can choose an input unit from 
nm/um/mm. 

Mode Specifies the defocus mode from symmetric/asymmetric.  
In the case of the symmetric mode, the defocus value of the 
center image is  assumed to be zero. 

In-focus image does 
not show clear 
features 

When checked, the in-focus image will be aligned using the 
alignment information between under and over images. 
NOTE: When an in-focus image does not show clear image 
features, an image alignment may fail. Then, you  can use this 
option. 
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Start Defocus Specified a defocus value of the most under-focused image (the 
first image in the series).  
This box is only available for the asymmetric defocus mode. 

Pixel Size An image sampling distance in object space in nm. 

Acc. Voltage Specify a high voltage setting (in kV) 

Source Images Specifies the number of images to be setup from Three  Images 
and Two Images (Five Images will be available in future) 

 
 

Option Tab 

 
 

Component Description 

Phase Unit Unit of phase display is selected from Radian and Wavelength. 

Dud Pixels 

Quick Dud Pixel 
Check 

When checked, abnormal pixels will be eliminated based on the 
standard deviation (Sigma) of the whole image. 

Dud Pixel 
Threshold 

Specifies the threshold for a quick dud pixel check in standard 
deviation (Sigma). 
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Alignment... Menu 
 

Alignment Submenu 

 

The options in the Alignment... submenu are described below. 
 

Option Description 

Manual... Starts Manual Alignment. 

Affine... Starts Affine or Affine-Segment alignment. 

Translation... Starts translation-only automatic alignment. Any mouse clicks 
will be ignored when present. 

Fourier... Starts Fourier or Fourier-Affine alignment. 

Segment... Starts Segment alignment. 

Use Previous 
Alignment... 

Starts alignment using the previously determined alignment 
information. This alignment mode is useful, when the derived 
images, such as edge-enhanced images, give good alignment 
information. 

 
 

Manual Alignment Submenu 
The manual alignment will use HREM mouse clicks or a line annotation or ROI for initial 
rough alignment. Then, you can perform fine adjustment manually using the Manual 
Alignment Tool explained below. 

 

NOTE:  When you want to align images using a set of HREM mouse clicks or a line 
annotation or ROI, you have to place the same number of mouse clicks or a line 
annotation or ROI on each image before select this alignment command. 
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Display Adjustment Dialog  
Manual alignment requires the images normalized between 0 and 1. The normalization 
scheme will be selected from Contrast Limit/Local Variance/None using this dialog. 

 

 

The components of the dialog are described below. 

Component Description 

Image intensity will be adjusted before alignment according to the intensity range 
or the range of intensity variance of each image.  

Contrast Limits  When this tab is selected, image intensity is adjusted 
using the contrast limit same as the DM display limits. 

Local Variance  When this tab is selected, image intensity is adjusted based 
on the image variance of each image. 

None Tab When this tab is selected, image intensity is not adjusted 

Normalize When checked, image intensity is normalized to one after image 
adjustment.  

If you don't want to change the intensity scale, you can disable 
the normalization. 

OK Closes the dialog and performs alignment using the specified 
parameters. 

Cancel Closes the dialog without aligning the images. 
 

 
Contrast Limit Mode 
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Component Description 
Remove outliers 
(Lowest /Highest) 

Display limits (Lowest and Highest values) are defined by 
excluding the specified % of outliers (same as DM display 
limits). 

Adjust Local Mean When checked, the background is adjusted using the local 
mean. The size of small area to evaluate the local mean is 
specified in pixels. 

Check Click to check the effect on contrast adjustment. 

 
Local Variance Mode 

 

 

Component Description 

Local Area Size Specifies the size of small area to evaluate the local variance in 
pixels. 

Display Range Specifies display range in terms of local standard deviation 
(std). Namely, the display range will be +/- *(std) around the 
local mean. The intensity outside the range will be clipped. 

Check Click to check the effect on contrast adjustment. 

 
None Mode  
Inage intensity will not be adjusted. 
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Manual Alignment Tool 
 

 
 

Current Images Box. 
 

Component Description 

Reference Specifies the Reference Image i.e. the one which will remain 
fixed. 

Target Specifies the Target Image i.e. the one which will be 
shifted/magnified/rotated to align with Reference image. 

Start Starts Manual Alignment with selected images. 

OK Applies specified translation, scale and rotation angle to the 
target image. 

Cancel Cancels the procedure. 
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Manual Alignment Tab  
 

Component Description 
Translation Translates the Target image with respect to the Reference 

image, in the direction of the arrow.  
Keyboard arrow keys can  be used to change four directions 
(up/down, right/left). NOTE: If the arrow keys do not work, click 
one of the translation arrows once.) 

Step Step for one click in pixels. 

Scale Magnifies or de-magnifies the Target image with respect to the 
Reference image. 

Step Step for one click in fractions of scale change. 

Angle Rotates the Target image, clockwise or anticlockwise, with 
respect to the Reference image. 

Step Step for one click in degrees. 

Display mode Display mode may be selected from the pull-down list:  
Sum (RGB) / Sum (B/W) / Difference / Flash (RGB) / Flash (B/W) 
/ Checker Board (RGB) / Checker Board (B/W) 

CB Size 
(Checker Board) 

Defines the checker board size (in pixels) for Checker Board 
(CB) display mode. 

Flash FPS 
(Frame Per Second) 

Defines Image flash rate for Flash mode display.  
(Actual flash rate is hardware dependent.) 

Reset Returns the Target image to initial orientation. 

OK Creates an aligned image. 

Cancel Cancels the procedure. 
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Affine Alignment Submenu 
The Affine alignment will use HREM mouse clicks to indicate the centers of the local areas 
to be used for the cross-correlation between the reference and target images.   

Without the mouse clicks, the evenly distributed 3 x 3 points will be used as the centers for 
the cross-correlation.  

NOTE:  When you want to align images using a set of mouse clicks, you have to place the 
same number of mouse clicks on each image before select this alignment 
command. 

Alignment Setup Dialog (Alignment Tab) 
 

 

The components of the dialog are described below. 
 

Component Description 

Alignment Tab For information about the components of the Alignment tab, 
see  Alignment Tab Below. 

Options Tab For information about the components of the Options tab, 
see  Option Tab Below. 

Display Tab For information about the components of the Display tab, 
see   Display Tab Below. 

OK Closes the dialog and opens a dialog to specify the image(s) to 
be aligned. 

Cancel Closes the dialog without acquiring images. 
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Alignment Tab 
 

Component Description 

Scheme Box 

Scheme Alignment Scheme will be selected from: 

Affine: Linear alignment (Affine transform) using local cross-
correlations between pre-defined image areas. A single scale 
and rotation will be applied over the whole image. 

Affine->Segment: After Affine alignment, non-linear Segment 
alignment using local cross-correlations between small 
segments of the image area will be performed. 

Cycle Maximum number of iterative alignments. 

Reference Image Specifies a reference image for alignment. 

Cross-Correlation Box 

Mode Cross-correlation mode will be selected from: 

Conventional: cross-correlation using amplitudes. 

Square Root Moduli: cross-correlation using square root of 
amplitudes. 

 Phase Only: cross-correlation using unit amplitudes (only 
phase will  be retained). 

None: Mouse points or end points of line(s) will be simply used 
for alignment (same as manual alignment). 

Size Cross-correlation size: 32/64/128/Full. In the case of 'Full' any 
mouse points or end points of line(s) will be ignored even when 
present. 

Mask Specifies a radius of Low-pass filter in Fourier space (relative to 
the  Nyquist frequency) to reduce high-frequency noise. 

Hanning Window When checked, a Hanning Window will be applied for 
Fourier transforms used for cross-correlation calculations. 
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Option Tab 
 

 
 

Component Description 
Affine/Fourier Box 

Scaling When checked, an estimated image scale will be applied. 

Rotation When checked, an estimated image rotation will be applied. 

Final Translation When checked, a translation alignment of the whole image will 
be done at the end of alignment.  
When an aligned project shows an incorrect translation, you may 
want to disable the final translation. 

Peak Search Box 

Size Radius of the search are for cross-correlation peak. 

Threshold Intensity below this level will be ignored when searching peak 
centers. 

Normalization When checked, image intensity is normalized to unity after image 
adjustment.  

If you don't want to change the intensity scale, you can 
disable the normalization. 

Trend Subtract If checked, a trend (slowly varying feature) is subtracted 
before alignment to enhance the image feature. 
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Display Tab 
 

 
 

Component Description 

Cross-Correlation When checked, cross-correlation patterns will be displayed. 

Difference Image When checked, a difference between under and over focus 
images will be displayed. This is useful to check an alignment 
quality. 

Message Level Controls the amount of output message to the Results Window. 
(None/Normal/Detail) 
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Translation Alignment Submenu 
NOTE:  The mouse clicks or a line annotation or ROI will be ignored for this alignment.  

Alignment Setup Dialog (Alignment Tab) 

 

The components of the dialog are described below. 
 

Component Description 

Alignment Tab For information about the components of the Alignment tab, 
see Alignment Tab Below. 

Options Tab For information about the components of the Options tab, 
see  Option Tab Below. 

Display Tab For information about the components of the Display tab, 
see  Display Tab Below. 

OK Closes the dialog and opens a dialog to specify the image(s) to 
be aligned. 

Cancel Closes the dialog without acquiring images. 
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Alignment Tab 
 

Component Description 

Scheme Box  

Scheme Translation: only translation will be applied.  

Reference Image Specifies a reference image for alignment. 

Cross-Correlation Box 

Mode Cross-correlation mode will be selected from: 

Conventional: cross-correlation using amplitudes. 

Square Root Moduli: cross-correlation using square root of 
amplitudes. 

 Phase Only: cross-correlation using unit amplitudes (only phase 
will  be retained). 

None: Mouse points or end points of line(s) will be simply used for 
alignment (same as manual alignment). 

Mask Specifies a radius of Low-pass filter in Fourier space (relative to 
the Nyquest frequency) to reduce high-frequency noise. 

Hanning Window When checked, a Hanning Window will be applied for 
Fourier transforms used for cross-correlation calculations. 

 

Option Tab 
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Component Description 

Peak Search Box 

Size Radius of the search are for cross-correlation peak. 

Threshold Intensity below this level will be ignored when searching a 
peak. 

Normalization When checked, image intensity is normalized to unity after image 
adjustment.  

If you don't want to change the intensity scale, you can 
disable the normalization. 

Trend Subtract If checked, a trend (slowly varying feature) is subtracted 
before alignment to enhance the image feature. 

 
 

Display Tab 
 

 
 

Component Description 

Cross-Correlation When checked, cross-correlation patterns will be displayed. 

Difference Image When checked, a difference between under and over focus 
images will be displayed. This is useful to check an alignment 
quality. 

Message Level Controls the amount of output message to the Results Window. 
(None/Normal/Detail) 
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Fourier Alignment Submenu 
The Fourier alignment requires HREM mouse clicks on some spots of the Fourier transform 
generated from the reference image. Thus, you have to calculate Fourier transform of the 
reference image, and then place some mouse clicks on the spots before selecting this 
alignment command. 

 

Alignment Setup Dialog (Alignment Tab) 
 

 

The components of the dialog are described below. 
 

Component Description 

Alignment Tab For information about the components of the Alignment tab, 
see Alignment Tab Below. 

Options Tab For information about the components of the Options tab, 
see Option Tab Below. 

Display Tab For information about the components of the Display tab, 
see  Display Tab Below. 

OK Closes the dialog and opens a dialog to specify the image(s) to 
be aligned. 

Cancel Closes the dialog without acquiring images. 
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Alignment Tab 
 

Component Description 
Scheme Box 

Scheme Alignment Scheme will be selected from: 

Fourier->Affine: After rough alignment using the specified 
spot positions of Fourier transforms, Affine transform in real 
space will be performed using local correlations between  pre-
defined 3x3 image areas  

Fourier: Linear alignment using the specified spot positions of 
Fourier transforms. 

Cycle Maximum number of iterative alignments. 

Reference Image Specifies a reference image for alignment. 

Fourier Transform Fourier transform of the Reference Image will be selected from 
the image list. This Fourier transform image should have some 
mouse points. 

Cross-Correlation Box (Cross-correlation is only effective for Fourier-Affine alignment) 

Mode Cross-correlation mode will be selected from: 

Conventional: cross-correlation using amplitudes. 

Square Root Moduli: cross-correlation using square root of 
amplitudes. 

 Phase Only: cross-correlation using unit amplitudes (only 
phase will  be retained). 

None: Mouse points or end points of line(s) will be simply 
used for alignment (same as manual alignment). 

Size Cross-correlation size: 32/64/128/Full. In the case of 'Full' any 
mouse points or end points of line(s) will be ignored even when 
present. 

Mask Specifies a radius of Low-pass filter in Fourier space (relative to 
the  Nyquist frequency) to reduce high-frequency noise. 

Hanning Window When checked, a Hanning Window will be applied for 
Fourier transforms used for cross-correlation calculations. 
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Option Tab 
 

 
 

Component Description 

Affine/Fourier Box 

Scaling When checked, an estimated image scale will be applied. 

Rotation When checked, an estimated image rotation will be applied. 

Final Translation When checked, a translation alignment of the whole image will 
be done at the end of alignment.  
When an aligned project shows an incorrect translation, you may 
want to disable the final translation. 

Peak Search Box 
Size Radius of search area for the peaks on Fourier transform and/or 

the cross-correlation peak. 
Threshold Intensity below this level will be ignored when searching peak 

centers. 

Normalization When checked, image intensity is normalized to unity after image 
adjustment.  
If you don't want to change the intensity scale, you can disable 
the normalization. 

Trend Subtract If checked, a trend (slowly varying feature) is subtracted before 
alignment to enhance the image feature. 

 
  



 
 

QPt 
 

44 

Display Tab 

 

 
Component Description 

Cross-Correlation When checked, cross-correlation patterns will be displayed. 

Difference Image When checked, a difference between under and over focus 
images will be displayed. This is useful to check an alignment 
quality. 

Message Level Controls the amount of output message to the Results Window. 
(None/Normal/Detail) 
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Segment Alignment Submenu 
This is non-linear position-dependent alignment, where the whole image is segmented into 
many small areas, and each image area will be displaced with different amounts. Before 
applying this alignment, the images should be well aligned with Manual or Affine alignment.  

NOTE:  When you want to align images using a set of mouse clicks, you have to place the 
same number of mouse clicks on each image before select this alignment 
command. 

 
Alignment Setup Dialog (Alignment tab) 

 
The components of the dialog are described below. 

Component Description 

Alignment Tab For information about the components of the Alignment tab, 
see Alignment Tab Below. 

Options Tab For information about the components of the Options tab, 
see Option Tab Below. 

Display Tab For information about the components of the Display tab, 
see  Display Tab Below. 

OK Closes the dialog and opens a dialog to specify the image(s) 
to be aligned. 

Cancel Closes the dialog without acquiring images. 
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Alignment Tab 
Component Description 
Scheme Box 

Scheme Segment: non-linear alignment using local correlations 
between small segmented image areas. 

Reference Image Specifies a reference image for alignment. 

Option Tab 

 
 

Component Description 
Normalization When checked, image intensity is normalized to unity after image 

adjustment.  
If you don't want to change the intensity scale, you can 
disable the normalization. 

 
 

Display Tab 

 
 
 

Component Description 

Cross-Correlation When checked, cross-correlation patterns will be displayed. 
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Difference Image When checked, a difference between under and over focus 
images will be displayed. This is useful to check an alignment 
quality. 

Message Level Controls the amount of output message to the Results Window. 
(None/Normal/Detail) 
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Use Previous Alignment Submenu 
NOTE:  Even when the mouse clicks or a line annotation or ROI exists on the image to be 

aligned, they will be ignored for this alignment., 

Alignment Setup Dialog (Alignment tab) 
 

 

The components of the dialog are described below. 
 

Component Description 

Alignment Tab For information about the components of the Alignment tab, 
see Alignment Tab Below. 

Options Tab For information about the components of the Options tab, 
see  Option Tab Below. 

Display Tab For information about the components of the Display tab, 
see Display Tab Below. 

OK Closes the dialog and opens a dialog to specify the image(s) to 
be aligned. 

Cancel Closes the dialog without acquiring images. 
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Alignment Tab 
 

Component Description 
Scheme Box 

Scheme Use Previous Alignment: Alignment information of previously 
aligned project will be applied.  
In this case, the aligned project should  be derived from the 
same original images to be aligned. This alignment mode is 
useful, when the derived images, such as edge-enhanced 
images, give good alignment. 

Aligned Project Aligned project will be selected from the image list. 

 

Option Tab 

 
 

Component Description 
Normalization When checked, image intensity is normalized to unity after image 

adjustment.  
If you don't want to change the intensity scale, you can 
disable the normalization. 

 
 

  



 
 

QPt 
 

50 

Display Tab 
 

 
 

Component Description 

Difference Image When checked, a difference between under and over focus 
images will be displayed. This is useful to check an alignment 
quality. 

Message Level Controls the amount of output message to the Results Window. 
(None/Normal/Detail) 
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Phase… Menu 
Selecting this menu opens the QPt tool that calculate the phase images. Before 
selecting this menu, the front image should be an aligned project image. 

The phase image will be displayed in a new window, when you click ‘Done’ at the 
bottom of this tool. 

 
Phase Tool 
 

 
 

Component Description 

High Pass Filter The value of the high pass filter (HPF) in the box can be 
adjusted by the slider or the up/down arrows,  

Alternatively, you can directly input a number in the box. In this 
case, you can specify a non-integer number.  

Auto Survey When checked, Auto Survey to the Phase image will be 
activated. 

Done Creates the phase image according to the specified parameters. 

Cancel Cancels the procedure. 
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Manual Adjust for Phase…Menu 
You can finely adjust an aligned project manually by directly observing the changes of the 
phase map. This command uses the same tool for Manual Alignment. 

 
Manual Adjust Tool (Manual Adjust Tab) 

 
 

 
 
 

The relative displacement and/or rotation of the under-focus image (Target) with respect to 
the over-focus image (Reference) are manually adjusted as a final tuning of the phase map.  

The components of the Manual Adjust Tab are described below. You may note that the 
components are identical with the Manual Alignment Tool. 

 
Component Description 
Translation Translates the under-focus (Target) image with respect to the 

over-focus (Reference) image, in the direction of the arrow.  
Keyboard arrow keys can  be used to change four directions 
(up/down, right/left). NOTE: If the arrow keys do not work, click 
one of the translation arrows once.). 

Step Step for one click in pixels. 

Scale Magnifies, or de-magnifies, the under-focus (Target) image with 
respect to the over-focus (Reference) image. 
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Step Step for one click in fractions of scale change. 

Angle Rotates the under-focus (Target image), clockwise or 
anticlockwise, with respect  to the over-focus (Reference) image. 

Step Step for one click in degrees. 
Display mode Display mode may be selected from the pull-down list: 

Sum (RGB) / Sum (B/W) / Difference / Flash (RGB) / Flash (B/W) 
/ Checker Board (RGB) / Checker Board (B/W) 

CB Size 
(Checker Board) 

Defines the checker board size (in pixels) for Checker Board 
(CB) display mode. 

Flash FPS 
(Frame Per Second) 

Defines Image flash rate for Flash mode display.  
(Actual flash rate is hardware dependent.) 

Reset Returns the project image to initial orientation. 

OK Creates a re-adjusted project image and regenerate a phase 
image. 

Cancel Cancels the procedure. 
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Band Pass Filter…Menu 
This is a special Band Pass Filter that passes also the center beam. Thus, the mean value 
of the image will be kept constant. (NOTE: Bandpass Mask tool of DM cuts the low 
frequency   including the center beam, thus the mean value of the filtered image becomes 
zero.) 

 
How to use: 

1. Select a project or image 
2. Choose the command (Band Pass Filter) 
3. Input the smoothing edge size of the band-pass filter in pixels as shown below: 

 
The filter edge will be smoothed as exp(-(Distance/Edge)**4), where Edge is the Smooth 
Edge size and Distance is the distance from  the edge. 

If you press OK, then the Fourier transform of the image with the band-pass mask and 
the control dialog appear as shown below:  

 

 

 
4. Adjust the size of Band-pass Mask on the Fourier transform in the same way of using 

the Bandpass mask of the DM, and then select Apply in the control dialog. 
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Propagate WF… Menu 
Using this menu, you can propagates the wave function (WF) manually, by a specified 
distance (defocus) or a set of distances (defocuses). This command is useful, if the center 
image is not exactly in-focus. 

 
Propagate WF Submenu 
 

 

 

Manual Defocus You can propagate the wave manually using an interactive 
tool:  Propagate tab of the QPt Tools. 

Focal Series Waves at a series of defocuses will be calculated. 

Single Defocus The wave at the specified defocus will be calculated. 
 
 
Manual Defocus Submenu 
Manual Defocus tool (Propagate Tab) 

 
Component Description 
Defocus Distance of wave propagation (defocus) in the specified unit. 

You can directly specify the defocus in the box. A negative value 
corresponds to back-propagation. 
Alternatively, you can use up/down arrows to change the defocus. 

Step The defocus step for the up/down arrows. 

Unit Defocus unit (nm/um/mm) 

Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to remove high-
frequency noise.  

High Pass Filter Input the value of the high pass filter (HPF) in pixels of Fourier 
space. Alternatively, HPF can be adjusted by using the slider 
or the up/down arrows,  
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Done Creates the last propagated WF in a new image window.. 

Cancel Cancels the procedure. 

 

Focal Series Submenu 
A set of defocused images (focal-series images) will be calculated and saved into a stacked 
image. 

 
Focal Series dialog (Control Tab) 

 

 

Control Tab 
Component Description 

Start Defocus Specify the start defocus in the unit of original images. 

Last Defocus Specify the last defocus in the unit of original images. 
Defocus Step Specify the defocus step in the unit of original images. 

Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to remove high-
frequency noise. 

HPF Input the value of the high pass filter (HPF) in pixels of Fourier 
space.  

 

Display Tab 

 
 

Component Description 

Message Level Controls the amount of output message to the Result Window. 
(None/Normal/Detail) 
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Single Defocus Submenu 
Single Defocus dialog 

 
Control Tab 

Component Description 

Defocus Distance of wave propagation (defocus) in the specified unit. A 
negative value corresponds to back-propagation. 

Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to remove high-
frequency noise. 

HPF Input the value of the high pass filter (HPF) in pixels of Fourier 
space. 

 
Display Tab 

 
 
 

Component Description 

Message Level Controls the amount of output message to the Result Window. 
(None/Normal/Detail) 
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Aberration Corrector ... Menu 
This command opens Aberration Corrector window (if not opened).The aberration 
corrector becomes active, only when the Rectangle ROI is placed on the image. 
Aberration correction is applied on the fly to the image within the ROI. The same 
aberration will be applied to the whole image, when the Apply button is pressed. 

 
Definition of the aberration coefficients: A pre-factor of 1/(n+1) is applied to the Modulus of 
n-th order aberration coefficient. For example, for the second order Coma (B2) the actual 
modulus is Modules/(2+1). 

 
Aberration Corrector tool 

 
The components of the window are described below. 

 
Component Description 

Rotation Tab Rotational aberrations, namely defocus, and 3rd and  fifth 
order spherical aberrations. See Rotation Tab below. 

Basic Tab Basic non-rotational aberrations, namely two-fold 
astigmatism, coma and three-fold astigmatism. See     Basic 
Tab below. 

3rd-order Tab Third order (non-rotational) aberrations. See Basic Tab 
below how to adjust the parameters. 

4th-order Tab Forth order (non-rotational) aberrations. See Basic Tab 
below how to adjust the parameters. 

5th-order Tab Fifth order (non-rotational) aberrations. See Basic Tab below 
how to adjust the parameters. 

Display Selection the display mode from 
Imaginary/Real/Modulus/Log of Modulus/Phase. 

PCTF Button Phase Contrast Transfer Function (Imaginary part of   the 
aberration function) will be displayed in a separate PCTF 
window. The image size will be specified in the Show PCTF 
dialog. 

Apply Aberration correction with the current selections will be 
applied to the whole image, and the result will be displayed 
in a new window.. 
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Rotation Tab 

 

Rotational aberrations, namely defocus (C1), 3rd order 
spherical aberration (C3) and fifth order spherical 
aberration (C5), will be adjusted by a value shown in the 
Value box.  

You can input directly a number in the Value box, or 
adjust it using the up/down triangles with a step in the 
Step box. 
 

 
 

Basic Tab 

 

Basic non-rotational aberrations, namely two-fold 
astigmatism (A1), coma (B2) and three-fold astigmatism 
(A2), will be adjusted.  

The Modulus will be specified directly in the Value box, or 
adjusted using the up/down triangles with a step in the 
Step box.  

The Angle will be specified directly within the circle, or 
adjusted using the up/down triangles.  

 
3rd, 4th and 5th Tabs 
You can adjust the higher-order aberrations in the same way as you adjust the above Basic 
Aberrations. 
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QPt Only 

 
 

Menu Description 

Field Filter  Creates Magnetic/Electric Field Images. For more information 
on various options of the field filter image, see each sub-menu: 
Magnetic/Electric Field (Raw), Field Density Map, Rotate 
Coordinate. 

Manual Adjust for 
Field Filter…  

Adjusts an aligned project image manually and updates the 
phase and/or field filter image. 

Knife Edge…  Displays a knife-edge image (Schlieren image). For more 
information on the knife edge image, see Knife Edge Image 
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Field Filter Submenu 

 
 
 

Submenu Description 

Magnetic/Electric 
Field 

The magnetic/electric field image will be calculated from the 
project image, for which the phase has been already 
calculated. Here, the vector field is RGB color-coded with 
arrows showing the vector direction and magnitude.  
You can change appearance of the vector field image using 
Setup dialog. 

Magnetic/Electric  
Field Raw 

Two (x and y) components of the magnetic/electric vector field 
are coded into real and imaginary parts of complex image. Thus, 
you can quantitatively analyze the field vector. 

Field Density Map… Displays a two-dimensional histogram of magnetic/electric 
field vectors. You can change appearance of the field density 
map using Field Density Map dialog. 
Before selecting this menu, the front image should be a 
magnetic/electric field image. 

Rotate Coordinates… Rotates the x-direction (preferred direction) of the vector field 
coordinate.  

Display Control 

Color (On/Off) 
Direction (On/Off) 
Arrows (On/Off) 
Blend (On/Off) 

Toggles color display of the vector field. 
Toggles the directional display of the color map. 
Toggles displaying arrows. 
Toggles image blending.   

Color Wheel/Bar… Shows a color wheel or bar. 

Setup… Opens the Field Filter Setup dialog where you can control an 
arrow display and an image blending. For more information 
see Setup submenu 
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Field Density Map… Submenu 
Field Density Map dialog 

 

 
 

Component Description 

Image size Size of the field density map in pixel. 

Pseudo-Color When checked, the field density map is displayed in pseudo-
color. (When unchecked, the field density map is displayed in 
gray-scale.) 

Show Color Wheel When  checked, an RGB color wheel will be displayed in the 
separate window of the specified size. 

Exclude edge region When checked, the border area with the specified width will not 
be included in the histogram.  
NOTE: In many cases, the border area is contaminated  with the 
FFT artifacts. 
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Rotate Coordinates… Submenu 
Rotates the x-direction (preferred direction) of the vector field to the specified  angle from the 
horizontal direction. 

The magnitude of the vector field along or perpendicular to the preferred direction can be read 
easily from the x and y component images or from the real or imaginary part of the complex image. 

 
Rotate Coordinates Dialog 

 

 
 

Component Description 

X-Direction Specifies the x-direction (preferred direction) of the vector 
coordinates. You can directly put a value to the box, or use the 
Line  ROI to specify the direction. 

Display Mode X, Y component: Two images will be created for X and Y 
components. 
Complex image: A single complex image will be created. 

OK Creates a new vector field in the rotated coordinates. 

Cancel Cancels the procedure. 
 
 
 
 

Display Control Submenus 
 

Submenu Description 

Color (On/Off) Toggles color display 

Direction (On/Off) Toggles displaying direction information. 

Arrows (On/Off) Toggles displaying arrows showing a magnitude and direction. 
An interval, length and color of the arrow will be controlled by 
the Setup submenu. 

Blend (On/Off) Toggles image blending. An image to be blended and its blend 
ratio  will be controlled by the Setup submenu. 
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Color Wheel…/Color Bar… Submenu 
 

Submenu Description 

Color Wheel Creates a color wheel used to display a direction and 
magnitude of the Vector map. 

Color bar Creates a color bar used display a magnitude of the Vector map. 

 
 
 
 

Setup… Submenu 
You can control the properties of arrow display and an image blending for the field filter image 
display. 

 
Field Filter Setup dialog (Arrow tab) 

 

 

Arrow Tab 
 

Component Description 

Interval Specifies an interval to draw arrows (in pixel) 

Length Scale Specifies an arrow length in terms of Interval, namely an 
actual arrow length is Interval * Length Scale. 

Color Specifies an arrow color in RGB. 
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Blend Tab 
 

 
 

Component Description 

Blend Image Select a blend image from the sequence number of the images. 

Blend Ratio Specifies a blending ratio. 

Apply Blending When checked, the selected image will be blended. 

Contrast Limits 
(Low and High) 

The display limits of the field magnitude in RBG color will be 
specified here.  

The minimum and maximum field magnitudes are indicated 
for your reference. This is especially useful, if there are some 
abnormal points. 

Remove outliers When checked, the display limits are determined by excluding 
the outliers of specified amounts.  
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Manual Adjust for Field Filter… Menu 
 

You can finely adjust an aligned project manually by directly observing the changes of the 
phase and/or field filter map. This command uses the same tool for Manual Alignment. 

 
Manual Adjust Dialog 
 

 

Component Description 

Phase Image Tick to update a phase image. 

Field Image Tick to update a Field filter image. 

The selection(s) may be grayed out, when the phase or 
the field map is not created previously for the project. 

Manual Adjust Tool (Manual Adjust Tab) 

 
The relative displacement and/or rotation of the under-focus image (Target) with respect to 
the over-focus image (Reference) are manually adjusted as a final tuning of the phase and/or 
field map.  
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Component Description 
Translation Translates the under-focus (Target) image with respect to the 

over-focus (Reference) image, in the direction of the arrow.  
Keyboard arrow keys can  be used to change four directions 
(up/down, right/left). NOTE: If the arrow keys do not work, click 
one of the translation arrows once.). 

Step Step for one click in pixels. 

Scale Magnifies, or de-magnifies, the under-focus (Target) image with 
respect to the  over-focus (Reference) image. 

Step Step for one click in fractions of scale change. 

Angle Rotates the under-focus (Target) image, clockwise or 
anticlockwise, with respect  to the over-focus (Reference) image. 

Step Step for one click in degrees. 
Display mode Display mode may be selected from the pull-down list: 

Sum (RGB) / Sum (B/W) / Difference / Flash (RGB) / Flash (B/W) 
/ Checker Board (RGB) / Checker Board (B/W) 

CB Size 
(Checker Board) 

Defines the checker board size (in pixels) for Checker Board 
(CB) display mode. 

Flash FPS 
(Frame Per Second) 

Defines Image flash rate for Flash mode display.  
(Actual flash rate is hardware dependent.) 

Reset Returns the project image to initial orientation. 

OK Creates a re-adjusted project image and re-generate a phase 
and/or field image. 

Cancel Cancels the procedure. 
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Knife Edge… Menu 
Using this command, you can emulate a knife-edge image (Schlieren image) by manually 
controlling the knife edge position by using the Knife Edge tool. 

 
Knife Edge Tool 

 

 

 

Component Description 

Distance to center The distance of the knife edge (in pixels) from center of the 
Fourier transform of the image.  

This value can be adjusted by using the up/down arrows. 
Alternatively, you can directly input a number in the box. 

Angle The angle of the knife edge (+/-90 deg) in Fourier space.  

This value can be adjusted by using the clockwise/anti-clockwise 
rotation icons.  Alternatively, you can directly input a number in 
the box. 

Bright/Dark Field The knife edge will be inverted (the knife edge is rotated by 180 
degrees at the Fourier space center).  

Remove Knife Edge Tick to remove the knife edge in Fourier space. 

Done Creates the knife edge image. 

Cancel Cancels the procedure. 
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HREM Module (Optional) 
 
 

 
Menu Description 

Exit Surface WF... Opens the Exit Surface WF dialog where you can control the 
calculation. When you press 'OK,' a wave function at the 
specimen exit surface will be calculated. At the same time, a 
spherical aberration (Cs) as well as spatial and temporal 
dumping effects will be corrected. 

Minimum 
Amplitude WF... 

Opens the Minimum Amplitude WF dialog where you can 
control the calculation. When you press 'OK,' the wave function 
that shows minimum amplitude will be displayed. 

 
 

Exit Surface WF… Menu 
Exit Surface WF dialog 

 
Control Tab 

Component Description 

Cs Spherical aberration coefficient (in mm) 

Defocus Defocus value of the middle (in-focus) image (in nm) from the 
specimen exit surface. 

Defocus Spread When checked, the defocus spread specified in the box (in nm) 
will  be corrected. 

Beam Convergence Incident beam semi-convergence (divergence) angle in mrad.  
NOTE: The spatial frequency in Fourier space corresponds to 
[semi-convergence angle / wave length] (in 1/nm). 
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Cutoff (Aperture) Aperture radius in Fourier space (in 1/nm) to eliminate high-
frequency noise. 

Noise Control Noise magnitude used in a Wiener type Filter 

Display Tab 
 

 
 

Component Description 

Message Level Controls the amount of output message to the Result Window. 
(None/Normal/Detail) 

 
 
 
 
 

Minimum Amplitude WF… Menu 
 

 
Minimum Amplitude WF dialog 

Control Tab 

Component Description 

Start Defocus Start defocus of the defocus range to be searched for a minimum 
amplitude. 

Last Defocus Last defocus of the defocus range to be searched for a minimum 
amplitude. 

Defocus Step Defocus step of the defocus range to be searched for a minimum 
amplitude. 
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Display Tab 

 

Component Description 

Result Log When checked, complex wave functions at all the defocuses will 
be saved into a stacked image. 

Amplitude Std When checked, Std (standard deviation) of the amplitude 
distribution at each defocus will be displayed in line plot. 

Phase Std When checked, Std of the phase distribution at each defocus 
will be displayed in line plot. 

Message Level Controls the amount of output message to the Result Window. 
(None/Normal/Detail)   
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Utilities 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The menus of the Utilities are described below. 

Menu Description 

Check Derivative Displays an intensity derivative along the propagation direction. 
This command is useful to check an image alignment. You can 
use this command for the aligned project. 

Replace Dud Pixels A dialog asking a tolerance will be open, and bad (defect) pixel 
values determined with this tolerance will be replaced. This 
routine will work for the whole image or a selected image area. 

Trend Subtract Subtracts a trend (slowly varying feature) from the front image, 
and displays the result in the new image window. This 
command is useful to enhance the image feature. 

Extract Images Extracts all the component images from a project. 

Extract Current Slice Extracts one currently displayed image from a project. 

Complex to Real Converts a complex image to a real image type selected from 
Phase/Amplitude/Real/Imaginary/Intensity). 

Shift Wrapped 
Phase... 

Phase value will be shifted (added/subtracted) by a specified 
value in radians. 

Reactivate Reference 
Point 

Reactivate the reference points used for alignment on the re- 
opened image. (This command activates the reference point 
handler for a re-opened image. Note that the handler is 
terminated when the image is closed.) 

 


